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Welcome to Private Contact

Encrypted Contact Data

Private Contact is a program to manage and keep secret contact data regarding
persons, companies and institutions.

All data are saved on disk always and only in an encrypted form.

After closing them, documents can’t be correctly read without the right password.

Private Contact is the ideal software to store contact data containing reserved data.
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Getting Started with Private Contact

Start to Work with Private Contact

« Open a new document or use the one opened for you at startup.

« Using the icon toolbar or the bottom additional '+' command bar add a new
contact. When created, a contact is automatically selected and the content is put
in "Edit" mode

+ Insert the data of your contact

- Open the categories panel selecting 'Edit Categories...'under the 'Edit' menu

« Add and edit some labels modifying the color of the text and of the background.

 Go back to the main window and add others contact and assign different
categories to any contact selecting it from the popup menu

- Use the toolbar to filter contacts using category and search key

« Save your document to disk.

« Private Contact will ask you to specify a password to protect the document, you
will need this password in future to open the document. To save the document in
future you won't be asked again.

« Close the document. Try to open it (you need to remember the password assigned
to the document)

Done. You Created a new document filled with data, saved it encrypted and
reopened it decrypting it using the correct password
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Private Contact Reference

Documents

Private Contact is a standard Cocoa Document based application.
You can save as many disk based documents as you like and any documents can
contain as many contact data you like

Window Organization

Private Contact window is divided in two part, a left part with a list of all the contacts
categorized using categories and a right part showing the details of the selected
contact.

When a filter criteria is in action using the category popup or the search field in the
toolbar the left part shows only the contact passing the filter criteria. To show all the
contact again select "Show All" from the category popup in the toolbar and void the
content inside the search field

Toolbar

Private Contact uses a standard Mac Toolbar in the upper part of the window.
It acts as every standard toolbar in any Cocoa modern Mac application.

You can customize the toolbar in the standard way.

Right Click or Control-Click on the toolbar and select "Customize Toolbar..."

Adding Data

To add a contact select the Add icon from the toolbar or the bottom additional
command buttons.

When created a contact is automatically put in "edit" mode.

You can start insert data immediately.

If you are browsing data in "View" mode and need to modify it, you must switch from
"View" mode to "Edit" mode using the buttons inside the data or in the toolbar or
using the menu command.

Editing Categories

You can have a standard list of categories you can edit.

You can choose the color of the text and background.

At any moment you can insert or change the category assigned to a contact from
the popup menu inside the contact data.

When created, a new contact has its category set to default one.

To select a category to the default, use the "Edit categories" dialog, form the Action
Popup in the bottom command row.

Private Contact User Guide © 2006-2010 Tension Software page 4



Editing Labels

You can customize the labels of the field.

In that way you can use the fields for the data you really require.

To edit the labels choose 'Edit Labels...' under the 'Edit' menu.

After editing the labels the form (both the 'View' and the 'Edit") of Private Contact will
display the new labels reflecting your needs and the content of the data you want to
store.

Note that every document has its own set of personalized labels and the labels are
saved inside the document data fully encrypted.

So an hacker can't read even the label you chose and saved inside a document.

Browse Data

Private Contact shows the list of all the contacts inside the document on the left and
the detail of the selected contact on the right.

To browse the contact select the contact on the left.

You can order the contacts by category and by name selecting the column headers
in ascending and descending orders.

You can filter contacts using categories or a keywords or both using the category
and search field in the toolbar.

Save Data

Saving a Private Contact files is similar to saving in any document based Cocoa
application.

The first time you save a new document, Private Contact ask you to set a password
to protect it, after that, you never will be asked to insert again the password to save
the document.

You will need to remember it only to open the document.

Open Data

To open a document form disk select it from the "Open" dialog.

You will be asked the password to decrypt it.

Note that the document is not just locked but entirely encrypted.

There is no way to read the data inside your document without the password used
to save it.

Even an expert hacker can do noting with your document file if he doesn't know the
password.

Password

Before saving a document you need to set a password to protect it. It is not possible
to save a document without a password. At any moment the password protecting
the document can be changed selecting 'Password...' form the 'File' menu. If a
password was already set you will be asked to confirm the old one and to insert the
new one. Remember the password or your data will be lost.
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Encryption

When you save a document, the document is always saved as encrypted, Private
Contact do not save in plain format.

This to avoid saving in an unprotected mode.

This is because you can't save without specify a password.

All data inside your contacts are encrypted, also the list of categories you specified
for the document (it can contains reserved words).

Algorithm used for encryption is blowfish, a very strong encryption method, this offer
a high security for your data.

You are informed that loosing your password used to protect the document is equal
to loosing all the data inside the document.

Use our Password Repository or a similar program to save the different passwords
you use in your life or you can be in trouble one day specially if you need to
remember a password is a long time you don't use!

Don’t forget the Password

Without the password used to save the document, the document is just a bunch of
not readable data.

If you loose the password the document can not be decrypted.

Even we, the creator of the application can do nothing to help you to recover your
document if you loose your password.

We suggest, to save all your password using our application Password Repository
to avoid loosing your precious passwords.

Password Repository is available for download at www.pomola.com

Preferences

General

Specify the action to do at startup

« New Document: creates a new document at startup

- File browser: opens the dialog to select a Private Contact document from disk to
launch

 None: performs nothing at startup

« Open Selected Document: allows to select a document and have it launched
automatically at startup, this is a standard way to operate in case you use just a
single document as the main repository of your notes or use often the same
document.

To select a document you have 3 way:

- Pressing the select from disk button and select it from the open dialog that will
follow

- Dragging it from the finder or dragging it using the proxy icon (the icon in an
opened document in the title bar)

- Editing it in the edit field by keyword (the hard way)

Private Contact User Guide © 2006-2010 Tension Software page 6


http://www.pomola.com
http://www.pomola.com

®on General

Startup Action: | Open Selected Document 3

|

( Select from Disk... )

At any successive relaunch Private Contact will execute the option selected.
The additional two buttons at the foot of the edit field let you:

- Show in the finder the selected file

- Test open the selected file as it will be done at the next application launch

Edit

Settings used opening a new document:
« Ruler in the document visible
« Ceck Spelling as-you-type enabled

Opening a Document:

[ Start With Ruler
M Check Spelling as You Type Enabled

Advanced
Advanced settings:

» Font used in a new opened document
+ Font used to display the public note
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®eo0n Advanced
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General Edit Advanced Update

Default Font in New Document

Font: '; Helvetica

Size: | 12 5

Font in Public Note

a»

Font: | Helvetica

Size: | 12 -5

[1Bold [ !ltalic

Update

Private Contact can inform you if an update is available.

If enabled, the application will check no more then once a day.

‘Ask at startup’ asks you if you like to have the application check if an update is
available when you start the application

‘Disabled’ avoids any check

When you check if an update is available, the application ping the Tension Software
server and receive an answer about the last release available, the application can in
that way know if its obsolete or not.

In case the application will ask you if you like to download an upgrade.

0O Update

KNS ON©)

GCeneral Edit Advanced Update

Check for Software Update at Startup:

() Enabled (Checks in background once a day, no more)

() Ask at startup
() Disabled

Check for Software Update allows you to have the last release
available.

The check is performed only once a day (no more) in
background and is very fast.

Any successive launch on the same day won't perform the
check.

There is no bandwidth waste.

The check is performed in a separate thread and application
performance is not affected in any way.

_ Check Now | Check is executed in a separated thread in background

If you download the upgrade, you need to install it.
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A common error is to download an upgrade and install it maintaining the old
application somewhere on the hard disk.

Then using to open the documents sometime the old application and sometime the
new one. This cause some problems*. To avoid it simply install your application in
the place dedicated to it, the Application folder. When you install an update on the
standard Application folder, the system will ask if you want to replace the old one
with the new, answering yes will install the new one replacing the old.

*If the application says the document you are trying to open was created with a newer
version of the application, probably you have two different release of the application on your
Hard Disk and you are trying to open a document with the older version after having
modified the document with the new one. When you receive a similar message open the
about box inside the application and see if you are running the last release. In case
download it, install it and USE it!

Help

Private Contact provides a standard help menu ...maybe you already found it!
Under the help menu use the Visit Pomola.com to access our site a download the
very last version of Private Contact and other software for Mac we make.

Licensing the program

You can use the command under the Help menu to access our web site

From there you can purchase a license to use Private Contact using one of the
payment service we provide. It easy, fast, and secure.

Purchasing a license remove all the limitations inside Private Contact

If you are evaluating to purchase this software, consider that it is realized in Cocoa
and in Objective-C, the basis of all the last generation software for mac OS X, and
you can expect a long life for any products based on Cocoa. Mac OS X and the
Cocoa technology are estimated to have really really long life with continuous
improvements (more then the life of Mac OS Classic of around 15 years) because
Mac OS X and Cocoa are solid technologies (Mac OS classic was just a toy if
confronted with Mac OS X) and new features can be added without problems as the
time request them.

This software is Universal Binaries and runs native on both PPC Mac and Intel Mac.

If you decide to purchase a license, thank you for your support. When you see on
the net how much quality software there is for Mac and how much software is added
every day it is because users support small developers buying software.

History

Private Contact is a program developed in its first release in 2005 by the Tension
Software using as a basis the Cocoa Library and Objective-C with Apple X Code
development environment.

Cocoa is the modern, object oriented library at the core of many amazing things in
Mac OS X and Objective-C, the language which make possible to access all the
cool technology inside Cocoa, using an object oriented amazing dynamics
paradigm.

As a result of this, Private Contact doesn't inherit any legacy problem, it's just a
brand new application with a fast and smart interface, realized for the new and
coolest OS of the new millennium, Mac OS X, with the very last technology
available.
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The Cocoa Environment and Objective-C were inherited by Apple from Next (as
every one knows) and despite they are revisited and adjusted continuously by Apple
engineer they are based on algorithm that now are used from years and proved to
be rock solid and expandable (look at how many improvements was made on mac
OS X from the first release without altering its solidity).

Private Contact uses the same engine we used for Password Repository, our
program to save password encrypted, and considering Password Repository on OS
X already proved to be a reliable solution, we are confident also Private Contact will
prove the same thing when in use by Mac users around the world

The encryption mechanism used by Private Contact is the famous Blowfish, well
know for its solidity, efficiency and difficulty to crack, implemented and accessed in
C and Objective-C to obtain record performance managing encrypted data.

Support

You can also obtain support using the ‘Support Email...” command. An email will be
prepared using your email client with the correct address to send to.
Yes, we answer to your emails.

Private Contact is a Commercial Program

You can use our software for a test period of 10 days
After that you are required to buy a license to be legally authorized to continue to
use our software

Licensing Private Contact

You can buy a license to use our software using the ‘Buy License’ command under
the Help menu.

You will open in your browser our license web page on our web site

From there you can buy a license to use Private Contact using one of the payment
service we provide. It easy, fast, and secure and all most important form of payment
are accepted.

We carefully selected or international reseller to be sure the buying experience for
our customer will be as best as possible and without any problems.

After purchase you will receive from Tension Software a license email containing
your full name and a license code

Open the License dialog with the command ‘license’ under the ‘Private Contact’
menu and insert these data in the License dialog. The software will become fully
licensed and fully enabled for future use.

Name and license code are remembered by the program and don’t need to be re-
inserted at successive launch.

In case you move on a new Mac you need to re-insert your name and license

The license is valid for a single Macintosh. You can purchase for two Mac as long as
they are not used at the same time, as example a desktop and a laptop used by the
same user.

Consideration about Licensing Private Contact
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If you are evaluating to purchase this software, consider that it is realized using the
Cocoa library (the native last generation library on Mac OS X) and in the Objective-
C language (the first class language development on Mac OS X)

The two technology are the basis of all the last generation software for Mac OS X,
and you can expect a long life for any products based on Cocoa and coded in
Obijective-C.

Mac OS X and the Cocoa technology are estimated to have a really long life with
continuous improvements (more then the life of the now ancient Mac OS Classic
which was around 15 years) because Mac OS X and Cocoa are solid technologies
(Mac OS classic was just a toy if confronted with Mac OS X) and new features can
be added without problems by Apple when they are required.

It was not so easy with previous generation of OS.

In our opinion the Cocoa technology will live and grow for many decades from now,
so Cocoa based software are today the best way to go if you have to select software
to use.

If you decide to purchase a license, thank you for your support.

When you see on the net how much software there is for Mac and how much
software is added every day, it is because users support small developers buying
software and because the Macintosh software ecosystem it’s really a great place to
work due to the incredible success the Macintosh has today and the common
feeling of the community (we use the Mac because we love doing things in a smart
way).
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